
Contents for StatTrak for Baseball
Getting Started

Overview
First Game
Select Teams

Menu Options
File
Reports
Update
Options
Help

Statistics
Batting
Pitching
Fielding

Miscellaneous
Technical Support
Other Programs
Registration
License



Overview
StatTrak for Baseball is a Baseball/Softball Statistical Management System
for league, tournament, individual teams, and table-top games.    Keeps 
records for up to 100 teams per directory (99 players per team).    Tracks 
batting, pitching, fielding, team record, game results, box scores, and team 
standings.    Also includes a lineup function.    All StatTrak reports can be 
computed for any combination of games.    With batting, pitching, and 
fielding, you can design and save your own report formats, name additional 
categories, and sort on any category.    Reports can be printed or saved to 
disk.    This program is upgraded every year!

Unless this is a demo (shareware) version of StatTrak for Baseball, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you must immediately register with ALL-PRO 
Software or delete the program.    See the Registration Section for 
registration details and benefits.
Keep a score book for your team(s).    Start the program and select one or 
more teams.    Select Update from the Main Menu to update game and player
results.    Select Reports from the Main Menu to display and print the batting, 
pitching, fielding, team record, game results, box scores, and team standings
reports.
Back up your data regularly to protect against loss due to power failure, disk 
damage, or other mishaps.    This is very important!



First Game
To add your first game, select "Team 1", or another team,    from the list of 
teams.    Then from the Update Menu, select Team Name and assign the team
name, select Roster and add players to the roster, and then select Games 
and add the game and player results for the first game.    When adding a 
game, all game and player results are optional and can be added, changed, 
or deleted at a later time.
You might want to set up your game types, name additional categories, and 
change your data directory before adding your first game.    Select Name Your
Own from the Options Menu to set up your game types and name your own 
categories.    Select Data Directory from the File Menu to select the directory 
you want to store your team and player files.



Select Teams
StatTrak lets you select one or more teams on the team list.    If you select 
more than one team, only the first team selected on the list can be updated.  
However, you can report on more than one team at a time.    If you select 
more than one team, the Game Scores, Box Scores, Record, and Lineup 
options on the Reports Menu will be disabled.    If you select just one team, 
the Standings menu option will be disabled.    The Batting, Pitching, and 
Fielding menu options are available regardless of how many teams you 
select.
To select multiple teams, click and drag on the team list.    The Shift+click or 
Shift+arrow key extends the selection from the previously selected item to 
the current item.    Ctrl+click selects or deselects an item on the list.



File
Selecting File from the Main Menu provides the following menu options:

Data Directory - Select team and player file directory.
Back Up Files - Back up team and player files.
Restore Files - Restore team and player files.
Exit Program - Exit StatTrak for Baseball Program.



Back Up Files
Select Back Up Files from the File Menu to make a copy of your team and 
player files for your current working directory.    You might want to make a 
backup copy to a floppy disk and to your hard drive.    This way you have a 
backup copy you can quickly restore from on your hard drive and a copy on a
floppy disk that you can use should you ever experience problems with your 
hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Restore Files
Select Restore Files from the File Menu to load a backup of your team and 
player files to the current working directory.    You can restore from a backup 
made to a floppy disk or another directory on your hard drive.
If you plan to track your statistics on two computers, like home and work, 
you can back up your team and player files to a floppy disk and then load 
them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Help
Select Contents... from the Help Menu to run the StatTrak for Baseball Help 
Program.    Select About from the Help Menu to view the About Screen which 
shows the version number of StatTrak for Baseball and the All-Pro Software 
address.



Reports
To display reports, select one or more teams, select Reports from the Main 
Menu, and then select one of the following menu options:

Batting - Batting Statistics Report.
Pitching - Pitching Statistics Report.
Fielding - Fielding Statistics Report.
Game Scores - Game Scores Report (if one team selected).
Box Scores - Box Scores Report (if one team selected).
Record - Team Record Report (if one team selected).
Lineup - Lineup Function (if one team selected).
Standings - Team Standings Report (if two or more teams selected).

ALL StatTrak reports can be computed for any combination of games (i.e. all 
games, last 10 games, games 5 through 10, league games, etc.) and can be 
printed or saved to a disk file.



Batting, Pitching, and Fielding Reports
Select    Batting, Pitching, or Fielding from the Reports Menu to display team 
and player batting, pitching, or fielding statistics.    The reports will show 
players from one or more teams depending on the number of teams 
selected.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.    Click Sort to sort the report on any 
category in ascending or descending order.    The sort selection is saved to 
disk.    Click Format to select, add, change, or delete a report format; select 
the categories you want on the report in the left to right order you want 
them; select one category to create a category report.    Report formats are 
saved to disk.    Click Player to display an individual's game by game 
statistics.    Click Minimum to divide the report into two groups based on a 
minimum number of games, plate appearances, innings pitched, or fielding 
chances.
Use the vertical and horizontal scroll bars to scroll up/down and left/right on 
the report.    The scroll bars will only appear if scrolling is needed.    For 
example, if only three players appear on the report, the vertical scroll bar will
not be visible.
See Batting, Pitching, and Fielding Statistics for a list of all categories that 
can appear on the reports and how they're calculated.
To view career statistics for a player, select two or more teams and then 
compute the Batting, Pitching, or Fielding Report.    Then click Compute and 
enter a player's name or number and click OK. The report will display a 
statistics line for each team the player appeared in as well as a total line.    
For example, if Jeff Elwood played on the 1994 Warriors and the 1995 
Warriors, you would select both teams, compute the Batting Report, and then
recompute the report for Jeff Elwood to see his 1994, 1995, and career 
batting statistics.



Game Scores Report
Select Game Scores from the Reports Menu to display game results.    The 
report is only available if one team was selected.    The Game Scores menu 
option will be disabled if two or more teams were selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different games.      Click Short to display a one line 
game description which displays game number, game date, game type, 
opponents, and the score.    Click Long to display a more detailed game 
description which also shows the game location, innings played, and a game 
comment.    Both reports can be printed.



Box Scores Report
Select Box Scores from the Reports Menu to display the box scores for the 
selected team.    The report is only available if one team was selected.    The 
Box Scores menu option will be disabled if two or more teams were selected.
At bats, runs, hits, home runs, walks, strike outs, and runs batted in for each 
player are displayed a game at a time for the selected team.    Click Next, 
Previous, First, and Last to scroll through the games one at a time.    
This report will be enhanced (opponents box score, pitchers, other statistics 
like in the paper) in a future version of StatTrak for Baseball.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Team Record Report
Select Record from the Reports Menu to display the won/lost record for the 
selected team.    The report is only available if one team was selected.    The 
Record menu option will be disabled if two or more teams were selected.
Games won, games lost, win percentage (Pct), runs for (RF), and runs against
(RA) are displayed for each game type with recorded games and for total 
games.    Runs for are the runs the selected team has scored and runs 
against are the runs allowed by the selected team.    A column for ties will 
only be displayed if ties exist.
Win percentage in computed as ((wins + ties) / total games) where wins are 
1 point, ties are 1/2 point, losses are 0 points, and total games are 1 point 
per game.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.



Lineup Function
Select Lineup from the Reports Menu to create a team lineup.    Up to 25 
players can be added to the lineup.    For each player, fielding positions or 
managerial moves (i.e. "OUT", "PH", etc.) for up to 9 innings can be added.    
You can key in your own names and positions or select from a drop-down list 
box in each cell of the table.    The lineup is saved to disk.    This function is 
only available if one team was selected.    The Lineup menu option will be 
disabled if two or more teams were selected.
Click Print to print the lineup or save it to a disk file.



Team Standings Report
Select Standings from the Reports Menu to display team standings.    The 
report is only available if two or more teams were selected.    The Standings 
menu option will be disabled if less than two teams were selected.
Teams are listed in order of winning percentage.    The report displays games 
won, games lost, win percentage (Pct), winning or losing streak (Streak), runs
for (RF), runs against (RA), and games behind (GB) for each of the teams 
selected.
Runs for are the runs scored by a team and runs against are the runs allowed
by a team.    A column for ties will only be displayed if ties exist.
Streak is the latest consecutive number of wins or losses by a team.    For 
example, if a team has lost its last 5 games then the Streak is "Lost 5".    If a 
team won its last game but lost the game before that, the Streak would be 
"Won 1".
Win Percentage is computed as ((wins + ties) / total games) where wins are 1
point, ties are 1/2 point, losses are 0 points, and total games are 1 point per 
game.    Note that a team could be listed first because they have the highest 
win percentage and still be 1/2 or more games behind.    For example, a 1-0 
team will be listed first but will be 1/2 games behind a 3-1 team.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different games.
To create team standings, game scores must be recorded for all teams 
selected.    ONLY GAME SCORES are needed to create standings.    Game 
location, innings, etc., are not needed.    Batting, pitching, and fielding results
are also not needed.    However, each team must be added to StatTrak.    If 
team X plays team Y, you must add a game for team X and add a game for 
team Y.    Games for both teams can not be added at the same time.    They 
must be added separately.



Compute Reports
From ALL StatTrak reports, you can click Compute to recompute the report 
using the following selection criteria on the Compute Screen:

*    Game Range - Any range of games from 1 to 999.
*    Game Types - Any combination of seven game types    (renamed from 

Name Your Own).
*    Special Select - Check box to use ONLY Special Selected games. Lets 

you compute for non-consecutive game numbers (i.e. 1,3,9).    You can 
Special Select games when updating a game on the Game Screen or by 
selecting games on the Compute Screen.    Selections are saved to disk.

*    Include On-Error in OBP - Check box to include reaching base on-
error (OE) in the on-base percentage (OBP) calculation.    Will be saved to
disk.    Only available from Batting Report.

*    Innings per Game - Number of innings used to compute earned-run 
average (ERA) and strike outs per game (SOG).    Will be saved to disk.    
Only available from Pitching Report.

*    Career Statistics - Enter player name or number to compute career 
statistics.    Only available from the Batting, Pitching, or Fielding Reports 
when two or more teams are selected.

*    Fielding Positions - Check boxes for any combination of fielding 
positions.    Only available from Batting and Fielding Reports.

Click All from the Compute Screen to reset parameters for computing all 
games.    Click OK to compute report.



Print Reports
All StatTrak reports (Batting, Pitching, Fielding, Game Scores, Box Scores, 
Record, and Standings) can be printed or saved to a disk file.
When you print a report, you can either use the default report title or enter 
your own.    You can select from 1 to 50 copies and select the number of lines 
per page.    You can also select the font size for the report title and main body
of the report.    Some printers will not recognize font size but the report will 
still print.    Bold fonts can also be selected.    For the batting, pitching, and 
fielding reports, you can choose to print just the top X number of players (i.e.
League Leaders Report).
You can choose to create a report disk file instead of printing the report.    
Entering a file name will override printing.    You can specify a path with the 
file name and can either create a new report file, replace a report file, or 
append to an existing one.    Click Find... to search for a file.
Click Setup to bring up the Print Setup Screen to change printer parameters.



Update
To update team, player, and game information, select Update from the Main 
Menu and select one of the following menu options:

Games - Update team and player results.
Roster - Update player information on roster.
Team Name - Assign or change team name.
Change Player Number - Change player number.
Delete Files - Delete all data files (team name, roster, game 

results, player results) for the selected team.
A team must be selected before the menu options for Update are enabled.    
If more than one team is selected, only the first team selected on the team 
list can be updated.
* See also First Game.



Update Games
Select Games from the Update Menu to update game results.    The two 
components in updating a game are the Game Screen and the Player Screen.
General game information is (optionally) entered on the Game Screen and 
player batting, pitching, and fielding results are (optionally) entered on the 
Player Screen.
After selecting Games from the Update Menu you will advance to the Game 
Menu.    Click Add Game to add a game.    Highlight a game on the Game List 
and click Change to change a game,    click Delete to delete a game, or click 
Insert to insert a game.    You can also double-click a game on the Game List 
to change it.    Clicking Add Game, Change, or Insert will take you to the 
Game Screen.      If you just want to update player results for a game already 
added, you can highlight the game on the Game List and then click Player 
Screen to go directly to the Player Screen.    When you delete a game, ALL 
player results recorded for that game will also be deleted (be careful)!
From the Game Screen, you can update game date, game location, 
opponents, innings played, runs for (runs scored by the selected team), runs 
against (runs allowed by the selected team), home team, Special Select, 
game type, and game comment.    All entries on the Game Screen are 
optional, except game type.    Click OK to update game results.    When 
adding or inserting a game, clicking OK will automatically take you to the 
Player Screen.    However, when changing a game, clicking OK will take you 
back to the Game Menu.    Click Player Screen to advance to the Player 
Screen when changing a game.
One of seven game types is selected for every game updated (defaults to the
first game type).    Game types can be renamed by selecting Name Your Own 
from the Options Menu.    All StatTrak reports can be computed by game type.
For example, you could name game type 1 LEAGUE and game type 2 
PRACTICE.    Then you would select the LEAGUE game type when updating 
league games and the PRACTICE game type when updating practice games.   
Then you could compute any report for only league games, only practice 
games, or both league and practice games.
If you are tracking statistics or standings for two teams that played each 
other, you don't need to enter the same Game Screen information for both 
teams.    Add the game for one team first.    Then on the Game Screen for the 
other team select the opponent from the Drop Down List Box and then click 
Import to initialize the game information (date, location, innings, runs for, 
runs against, game comment (optional), game type) from what was entered 
for the other team.
On the Game Screen you can check Special Select, which is used in 
computing reports.    For example, you could Special Select night games and 
then compute any report for night games.    You can also Special Select 



games from the Compute Screen.
The other component in updating a game is the Player Screen where 
individual batting, pitching, and fielding results are entered.    Entering player
results is optional.    You can always add results later.
Click on the Player Table to select a player to update.    Click the "Bat" column
to update batting statistics, "Pitch" column to update pitching, or "Field" 
column to update fielding.    The row clicked determines which player is 
selected.    The area of the Player Table selected will be highlighted and the 
player name and appropriate categories will be displayed on the right.    A 
Baseball Icon indicates player results have been entered.    Click Roster to 
add players to the roster.    The total number of players with batting, pitching,
and fielding results are displayed below the Player Table.
Click the Player Table to select a player and batting, pitching, or fielding 
mode, and then enter the player results (possibly from a score book).    
Keying into any field will mark the player (Baseball Icon on Player Table and 
"Played in Game" Checked) as appearing in the game.    Check "Played in 
Game" to mark appearance of player in game (you might want to give a 
pinch runner or fielder an appearance even though all categories could be 
zero).    Uncheck "Played in Game" to remove appearance of player in game 
and to zero all entry fields.
Click Team Totals to display the team totals for batting, pitching, or fielding.   
This can be used as an auditing tool.    Click Game Screen to go to the Game 
Screen.    Click OK to save all the player results entered.    Click Cancel to 
cancel ALL the player results entered (not the last player entered but ALL the
players entered).    Clicking OK or Cancel will return you to the Game Menu.
You can select a primary fielding position when updating batting or fielding 
results.    Fielding position can be used when computing batting and fielding 
statistics.    For example, you could compute batting statistics for all 
shortstops in a tournament.
When entering batting, pitching, and fielding results you can record results 
for up to 5 Name Your Own categories.    These category names can be 
changed by selecting Name Your Own from the Options Menu.
See Batting, Pitching, and Fielding Statistics for lists of all statistics that can 
be recorded and computed by StatTrak for Baseball.



Update Roster
Select Roster from the Update Menu to set up and maintain a team roster.    
Up to 99 players can be added for each team.    Select from the player list 
and enter or change the name, phone number, address, city, state, zip, and 
other player information.    Click Delete to delete a player name and related 
information from the roster.    Click Print to print the roster.
Player names have an associated player number from 1 to 99.    One way to 
assign player numbers is to use the player's uniform number.    Currently, the 
only use of the player number is for computing career statistics.    However, 
career statistics can also be computed by player name.    The player number 
is used by StatTrak to identify players and does not appear on any reports.    
Deleting a player or changing a player name has NO effect on results 
recorded for that player number.    Player results relate to the player number, 
NOT the player name.
Don't get hung up on the player number.    It's a throw back from the DOS 
version of StatTrak for Baseball and will probably be eliminated in a future 
version of StatTrak for Baseball.



Update Team Name
Select Team Name from the Update Menu to assign or change a team name.  
You can assign a long team name and a short team name.    The short team 
name is only used on multiple team batting, pitching, and fielding reports.    
The long team name is used on all other reports and screens.    Click Default 
to assign the default team name based on the team number (i.e. Team 7).    
You might want to include the year in the team name for documentation 
purposes (i.e. 1993 Warriors).    This is especially helpful if you plan to record 
games for the same team in more than one year.
You might want to assign the team name before you set up the roster or add 
game results to make sure you're working with the correct team - the team 
name is listed on all update screens.    Changing the team name has NO 
effect on game and player results recorded for that team.    Game and player 
results relate to the relative team number, NOT the team name.



Change Player Number
Select Change Player Number from the Update Menu to move a player's 
name and statistics to another player number on the roster.    You can only 
change a player's number if NO results have been recorded for the number 
you want to change to.    This function could be used so a player has the 
same number every year for computing career statistics by player number.    
However, you can also compute career statistics by player name.
Player numbers do NOT appear on any reports.    Don't get hung up on the 
player number.    It's a throw back from the DOS version of StatTrak for 
Baseball and will probably be eliminated in a future version of StatTrak for 
Baseball.



Delete Files
Select Delete Files from the Update Menu to delete the team name, roster, 
game results, and player results for the selected team.    This function could 
be used to delete games that were added while experimenting with the 
program.
BE VERY CAREFUL USING THIS FUNCTION.    The team name, roster, 
game results, and player results recorded for the selected team will be 
permanently deleted!
Periodically make a backup copy of your game and player files.



Options
Selecting Options from the Main Menu provides the following menu option:

Name Your Own - Name your own game types and batting, pitching, 
and fielding categories.

The next version of StatTrak for Baseball will probably have an additional 
option to Create Your Own Statistics.



Data Directory
Select Data Directory from the File Menu to select the team and player file 
directory you want to work with.    Each directory can track up to 100 teams.
The StatTrak for Baseball Installation Program creates a \SAMPLES directory 
with World Series games for you to play with.    You should probably record 
your games in a different directory.    If you reinstall the program, you could 
lose your team and player files if they're in the \SAMPLES directory!
StatTrak will NOT make a directory for you.    You must do it.



Name Your Own
Select Name Your Own from the Options Menu to name game types and 
additional batting, pitching, and fielding categories.
With StatTrak every game is assigned a game type.    With Name Your Own 
you can name up to 7 game types.    For example, you could name game 
type 1 LEAGUE and game type 2 PRACTICE.    Then you would select the 
LEAGUE game type when adding league games and the PRACTICE game type
when adding practice games.    You could then compute statistics for league 
games by only selecting the LEAGUE game type on the Compute Screen, 
practice games by only selecting the PRACTICE game type, or league and 
practice games by selecting the LEAGUE and PRACTICE game types.    When 
computing reports, only the relative position of the selected game types are 
important, the names are just labels you assign.
With Name Your Own you can also name up to 5 additional batting, pitching, 
and fielding categories.    To track infield hits, you could name a category IH 
and then record results under that heading when adding player results.    
Then by selecting IH on the Format Screen, you could add infield hits to the 
Batting Report.    Naming a category is for labeling purposes only.    Statistics 
relate to the relative position of the Name Your Own category, NOT the 
category name.
You might want to name your own game types and additional batting, 
pitching, and fielding categories before you start adding games.    However, 
you can name your own game types and categories at any time.



Batting Statistics
Below is a list of the Batting Statistics that are tracked and computed by 
StatTrak for Baseball:

PA    Plate Appearances          CO        Catcher's Obstruction
R Runs                                    SO        Strike Outs
H Hits                                    SH        Sacrifice Hit (sac bunt)
2B Doubles        SF        Sacrifice Fly
3B    Triples                              DP        Double Plays Hit Into
HR Home Runs                          SB        Stolen Bases
OE Reaching On-Error            CS        Caught Stealing
BB Walks                  RBI      Runs Batted In
HP Hit by Pitch
B1, B2, B3, B4, B5    User Named Categories (renamable)
G        Games                              = number of BATTING records on file
AB      At Bats                          = PA - BB - HP - SH - SF - CO
1B      Singles                          = H - 2B - 3B - HR
TB      Total Bases                  = H + 2B + (2 * 3B) + (3 * HR)
SLG    Slugging Percentage = TB / AB
OBP    On-Base Percentage    =

                          (H + BB + HP) / (AB + BB + HP + SF) <== Major League Method
                      or    (H + BB + HP + OE) / (AB + BB + HP + SF)

BA      Batting Average          = H / AB
RC      Runs Created               = ((H + BB) * TB) / (AB + BB)
TA      Total Average        = (TB + SB + BB + HP) / (AB - H + CS + DP)

* See also Pitching and Fielding statistics.



Pitching Statistics
Below is a list of the Pitching Statistics that are tracked and computed by 
StatTrak for Baseball:

IP      Innings Pitched                SF        Sacrifice Fly
R        Runs                                      WP        Wild Pitch
ER      Earned-Runs                        BK        Balks
BF      Batters Faced                    GS        Games Started
H        Hits                                      GF        Games Finished
HR      Home Runs CG        Complete Games
BB      Walks      W          Wins
HB      Hit Batter L          Losses
CO      Catcher's Obstruction    SV        Saves
SO      Strike Outs                  SHO    Shutouts
SH      Sacrifice Hit (sac bunt)
P1, P2, P3, P4, P5      User Named Categories (renamable)
G        Games                              = number of PITCHING records on file
OAB Opponents At Bats = BF - BB - HB - SH - SF - CO
OAV Opponents Batting Avg = H / OAB
SOG Strike Outs Per Game          = (SO / IP) * Innings per Game
ERA Earned-Run Average    = (ER / IP) * Innings per Game

* See also Batting and Fielding statistics.



Fielding Statistics
Below is a list of the Fielding Statistics that are tracked and computed by 
StatTrak for Baseball:

PO      Putouts
A          Assists
E            Errors
DP      Double Plays
PB Pass Balls on Catcher
SB Stolen Bases on Catcher
CS Caught Stealing by Catcher
F1, F2, F3, F4, F5      User Named Categories (renamable)
G        Games                              = number of FIELDING records on file
C        Chances                          = PO + A + E
CSA Caught Sealing Average = CS / (SB + CS)
RNG Range Factor = C / G
FA      Fielding Average        = (PO + A) / C

* See also Batting and Pitching statistics.



Technical Support
For technical support:

* Call us at 608-271-1586.    Please don't use our 800 number which is 
reserved for orders.

* Fax us at 608-277-9195.
* Write us at All-Pro Software, 30 Maple View Court, Madison, WI 53719
* Email us at allpro@msn.fullfeed.com



Other Programs

Other Windows Programs available from ALL-PRO Software:
* StatTrak for Basketball $39.95 plus $3.75 s/h.

Works very much like StatTrak for Baseball!
* StatTrak for Soccer $39.95 plus $3.75 s/h.

Works very much like StatTrak for Baseball!
* ALL-PRO League Scheduler $49.95 plus $3.75 s/h.

Create round-robin schedules in minutes!
Handles division play and tracks scores and standings.

Other Windows Programs soon to be released by ALL-PRO Software:
Release Date

* StatTrak for Volleyball Fall of    1996
* StatTrak for Hockey Fall of    1996
* ALL-PRO Tournament Scheduler Early 1997

To order or for more information, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa).    International orders are welcome - call 608-271-1586!
Check out our Home Page (demos available for downloading):

http://www.msn.fullfeed.com/~allpro/
or Email us:

allpro@msn.fullfeed.com
Let us know what other features and sports programs you would like to see!



Registration
Unless this is a demo (shareware) version of StatTrak for Baseball, you must 
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you have an illegal copy and must immediately 
register with ALL-PRO Software or delete the program.
To register an illegal copy of StatTrak for Baseball, call ALL-PRO Software at 
800-SPORT-59 (MC/Visa) or send a check or money order for $39.95 + $3.75 
to ALL-PRO Software.    You will receive the latest version of StatTrak for FREE.
International orders please add $5 and send the check or money order in 
U.S. funds drawn on a U.S. bank.    Wisconsin Residents please add 5.5% 
sales tax ($2.20) for a total of $45.90.
To register a retail copy of StatTrak for Baseball, send the registration card or 
proof of purchase to ALL-PRO Software if you wish to receive the benefits 
listed below.    No fee is required.
If you obtained the program from ALL-PRO Software, you are automatically 
registered and will receive the benefits listed below.
Registration Benefits:

*    You will be notified when major upgrades to StatTrak for Baseball are 
released.    They will be offered to you at a reduced price.    The program 
is upgraded every year.

*    You will be notified when other programs are released or upgraded by 
ALL-PRO Software.

* You can receive FREE technical phone support at 608-271-1586.    Please 
don't call the 800 number which is reserved for orders.    Thank you!



License
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING ITS MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.      NEITHER ALL-PRO SOFTWARE NOR ANYONE ELSE 
INVOLVED IN CREATING, PRODUCING OR DELIVERING THIS SOFTWARE SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF USE OF THIS SOFTWARE OR INABILITY TO USE THIS 
SOFTWARE.      IN NO EVENT SHALL ALL-PRO SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE REGISTRATION FEE, REGARDLESS OF THE FORM OF 
CLAIM.    THE ENTIRE RISK AS TO QUALITY AND PERFORMANCE IS WITH THE USER.
THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF WISCONSIN 
AND SHALL INURE TO THE BENEFIT OF ALL-PRO SOFTWARE.    ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR 
RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL 
COURT OF COMPETENT JURISDICTION LOCATED IN DANE COUNTY, WISCONSIN.    THE
PARTIES HEREBY CONSENT TO JURISDICTION OF SAID COURTS. 
THIS SOFTWARE AND THE DISKS ON WHICH IT IS CONTAINED IS LICENSED SOLELY 
TO YOU ON A PERPETUAL BASIS FOR YOUR OWN USE. THIS IS COPYRIGHTED 
SOFTWARE.    YOU ARE NOT OBTAINING TITLE TO THE SOFTWARE OR ANY 
COPYRIGHT RIGHTS.    YOU MAY NOT SUBLICENSE, RENT, LEASE, CONVEY, MODIFY, 
TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, DECOMPILE, OR 
DISASSEMBLE THE SOFTWARE FOR ANY PURPOSE.    RECEIPT AND USE OF THE 
PRODUCT IS YOUR AGREEMENT TO THE TERMS OF THIS LICENSE.




